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	Objective Portion
	25 @ 10 points each
	
	250 points

	Production Portion
	
	
	

	Job 1
	Letterhead
	
	100 points

	Job 2
	Database/Report
	
	150 points

	Job 3
	Spreadsheet/Chart
	
	175 points

	Job 4
	Mail Merge
	
	175 points

	Job 5
	Labels
	
	75 points

	TOTAL POINTS
	
	
	925 points


Failure to adhere to any of the following rules will result in disqualification:

1. Contestant must hand in this test booklet and all printouts. Failure to do so will result in disqualification.

2. No equipment, supplies, or materials other than those specified for this event are allowed in the testing area.  No previous BPA tests and/or sample tests or facsimile (handwritten, photocopied, or keyed) are allowed in the testing area.

3. Electronic devices will be monitored according to ACT standards. 

No more than ten (10) minutes orientation
No more than 90 minutes testing time

No more than ten (10) minutes wrap-up 

Do NOT open test booklet until instructed to do so.

Property of Business Professionals of America.  

May be reproduced only for use in the Business Professionals of America 

Workplace Skills Assessment Program competition.

SCORING SHEET

	Job 1—Letterhead 
	Points
	Score
	Total

	1. 
	Correct margins.
	25
	
	

	2. 
	Date code used at 2” from top of page.
	25
	
	

	3. 
	Correct information entered. (-2 each error)
	25
	
	

	4. 
	Creativity/Design
	25
	
	

	
	Total
	100
	
	

	Job 2—Database/Report
	
	
	

	1. 
	Data entered correctly for the eight records. (-2 each error)
	100
	
	

	2. 
	Sorted by last name and first name.
	25
	
	

	3. 
	No data is truncated.
	10
	
	

	4. 
	Printed landscaped report.
	15
	
	

	
	Total
	150
	
	

	Job 3—Spreadsheet/Chart
	
	
	

	1. 
	Data entered correctly. (-2 for each error)
	30
	
	

	2. 
	Correct formatting.
	25
	
	

	3. 
	Total and average are calculated correctly and labeled.
	25
	
	

	4. 
	Printed centered on the page (25) and printed with formulas (25).
	50
	
	

	5. 
	Exploded pie chart printed on a full page.
	25
	
	

	6. 
	Chart shows item labels (10) and percentage labels (10).
	20
	
	

	
	Total
	175
	
	

	Job 4—Mail Merge
	
	
	

	1. 
	Content (Grade based on production standards)
	100
	
	

	2. 
	Print with merge codes.
	50
	
	

	3. 
	Printed merged letters for NY participants.
	25
	
	

	
	Total
	175
	
	

	Job 5—Labels
	
	
	

	1. 
	Avery 5160 layout used.
	25
	
	

	2. 
	Sorted ascending by postal code.
	25
	
	

	3. 
	Printout.
	25
	
	

	
	Total
	75
	
	

	TOTAL POSSIBLE
	675
	
	

	OBJECTIVE POSSIBLE
	250
	
	

	TOTAL POSSIBLE POINTS
	925
	
	


GENERAL INSTRUCTIONS

1. Answer the 25 objective questions using the Scantron scoring sheet provided.  Write your contestant number on the Scantron sheet.

2. Make certain this test booklet contains Jobs 1-5.

3. Correct all errors.
4. For any problem where you would normally use your reference initials, use your contestant number.  Your name or initials should NOT appear on any work you submit.  Key your contestant number and job number in a footer on all documents in the lower left-hand corner of all work submitted.

5. You may use templates.  However, your creativity score may be lowered.

6. If you finish before the end of the testing time, notify the administrator of the contest.  Time may be a factor in determining the winner in the event of a tie.

7. When turning in your completed work, place your scoring sheet on top of all of your jobs.  The jobs should be arranged in numerical order.  Turn in all partial jobs completed.

You are employed by Professional Business Associates and have been asked to assist the managers with a variety of tasks.  Please follow the guidelines for our company when completing the work.
Multiple Choice
Identify the letter of the choice that best completes the statement or answers the question.
____
1.
__________ refers to the arrangement of data into tables and fields.

	a.
	File management
	c.
	Database design

	b.
	Database structure
	d.
	Normalization


____
2.
Which formula shows the correct way to calculate the total amount in cells A1 through A5?
	a.
	=COUNT(A1:A5)
	c.
	=SUM(A1:A5)

	b.
	=AVERAGE(A1:A5)
	d.
	=MAX(A1:A5)


____
3.
Today, the most widely used floppy disk is __________ inches wide and can store up to 1.44 megabytes of data or 1,457,664 characters.

	a.
	3.5
	c.
	3.25

	b.
	5.5
	d.
	5.25


____
4.
To display the AutoFormat dialog box and format a range automatically, use the AutoFormat command on the __________.

	a.
	File menu
	c.
	Format menu

	b.
	View menu
	d.
	Data menu


____
5.
What are the settings for L/R margins if you want a horizontal width of six inches?
	a.
	1.25”

	b.
	1”

	c.
	1.5”

	d.
	.75”


____
6.
To save a workbook a second time using a new name or on a different drive, __________.

	a.
	click Save on the File menu
	c.
	click Save As on the File menu

	b.
	press SHIFT+F12
	d.
	press CTRL+S


____
7.
To toggle between the values version and the formulas version of a worksheet, press __________.

	a.
	ALT+ACCENT MARK (´)

	b.
	ALT+ SINGLE QUOTATION MARK (')

	c.
	CTRL+ACCENT MARK (`)

	d.
	CTRL+SINGLE QUOTATION MARK (')


____
8.
Clicking the __________ in the Outlook Contact window allows a contact’s department, manager’s name, nickname, and even birthday to be entered.

	a.
	letter tab
	c.
	General tab

	b.
	Activities tab
	d.
	Details tab


____
9.
To quit Outlook, click the __________.

	a.
	Close button on the Outlook title bar
	c.
	Restore button on the Outlook title bar

	b.
	Delete command on the Edit menu
	d.
	Close command on the File menu


____
10.
The basic unit of a PowerPoint presentation is a(n) __________. 

	a.
	placeholder
	c.
	slide

	b.
	template
	d.
	object

	
	
	
	


____
11.
This _____ button on the Outlining toolbar in PowerPoint moves a selected paragraph and its collapsed subordinate text above the preceding displayed paragraph.
	a.
	Move Up
	c.
	Enhance

	b.
	Promote
	d.
	Expand


____
12.
______is a computer program that organizes data in a row and column format and can perform calculations and help analyze information.

	a.
	Spreadsheet
	c.
	Database

	b.
	Word processing
	d.
	Presentation


____
13.
To create a hypertext link you must enter the Internet address also known as the 
	a.
	Hypertext transfer protocol
	c.
	File transfer protocol

	b.
	e-mail address
	d.
	URL


____
14.
A __________ contains buttons, boxes, and menus that allow tasks to be performed more quickly than using the menu bar and related menus.

	a.
	format bar
	c.
	command bar

	b.
	status bar
	d.
	toolbar


____
15.
A __________ is a master copy of a type of document—a model document that includes standard and variable text and formatting and may include graphics.

	a.
	wizard

	b.
	template

	c.
	worksheet

	d.
	thumbnail


True/False
Indicate whether the sentence or statement is true or false.
____
16.
The number 123.567 should be defined as long integer format in a database.
____
17.
To select nonadjacent files in a file list, use the shift key.
____
18.
The wildcard symbols available for use in a query are the double period (..) and the question 

mark (?).
____
19.
In the Folder List, a plus sign to the left of a folder indicates that the folder is expanded.
____
20.
The best type of program to use for an inventory list would be a database.
____
21.
PowerPoint is a complete presentation graphics program that allows you to produce 


professional-looking databases.
____
22.
A spreadsheet program is the best choice for performing a mail merge with numerical data.
____
23.
Text in the notes pane can consist of notes to yourself or remarks to share with your 


audience.
____
24.
In a database, a unique identifier (primary field) could be a person’s last name.
____
25.
The mouse pointer becomes a different shape depending on the task being performed in 


Word.
 Please follow directions carefully.  Print out hard copies of documents as instructed.

Job 1:  Letterhead
1. Professional Business Associates has asked you to create a new letterhead. 
2. Include the information below as well as including an appropriate graphic and lines.  
3. Use a top and bottom margin of .5” and left and right margins of 1”.
4. Insert the date code approximately 2” from the top of the page.

5. Save the letterhead for a mail merge project in Job 3.

6. Print a copy for your records.

Professional Business Associates

5454 Cleveland Avenue

Columbus, OH  43231-4021

Phone Number:  (555) 555-0140
Fax Number:  (555) 555-0144
Website:  www.pba.org

Job 2:  Database/Report
Create a database, using only database software, of state representatives who have registered for an employment conference that will be held by Professional Business Associates.  Include all appropriate fields.  You will use this database again in Job 3.

· Create a landscaped report and sort by last name and first name.  Any format is acceptable as long as all fields are displayed.  Adjust the report so no data is truncated.  The title should be Professional Business Associates Conference.
	Professional Business Associates Conference Registration

	First Name Roxanne
	Last Name Schaaf

	Address 914 Boylan Avenue

	City South Easton
	State MA
	Postal Code 02375-0114

	Work Phone 508-555-7847
	Fax 508-555-5556
	E-mail Address rschaaf@pba.com

	Professional Business Associates Conference Registration

	First Name Julie
	Last Name Chen

	Address 777 Chelsea Lane

	City Fairport
	State NY
	Postal Code 11450-1553

	Work Phone 508-555-8547
	Fax 508-555-6555
	E-Mail Address jchen@pba.com

	Professional Business Associates Conference Registration

	First Name Janelle
	Last Name Mattson

	Address 3456 Affirmed Court

	City Huntington
	State WV
	Postal Code 56895-8965

	Work Phone 508-555-1259
	Fax 508-555-5656
	E-Mail Address jmattson@pba.com

	Professional Business Associates Conference Registration

	First Name Alex
	Last Name Mattson

	Address 818 North Main Street

	City Celina
	State MT
	Postal Code 85996-9696

	Work Phone 508-555-9696
	Fax 508-555-9595
	E-Mail Address amattson@pba.com

	Professional Business Associates Conference Registration

	First Name Henri
	Last Name Bonaparte

	Address 5325 East Union Boulevard

	City Bethlehem
	State PA
	Postal Code 18018-4042

	Work Phone 508-555-5214
	Fax 508-555-9587
	E-Mail Address hbonaparte@pba.com

	Professional Business Associates Conference Registration

	First Name Jennifer
	Last Name Lopez

	Address 823 Fielding Road

	City South Easton
	State MA
	Postal Code 02375-0114

	Work Phone 508-555-7847
	Fax 508-555-5556
	E-Mail Address jlopez@pba.com

	Professional Business Associates Conference Registration

	First Name Noah
	Last Name Brown

	Address 4888 Midvale Road

	City Fairport
	State NY
	Postal Code 11450-1553

	Work Phone 508-555-8547
	Fax 508-555-9555
	E-Mail Address nbrown@pba.com

	Professional Business Associates Conference Registration

	First Name Jon
	Last Name Walton

	Address 614 Taft Street

	City Huntington
	State WV
	Postal Code 56895-8965

	Work Phone 508-555-1259
	Fax 508-555-5656
	E-Mail Address jwalton@pba.com


Job 3:  Spreadsheet/Chart
1. Create the spreadsheet using the information in Table 1 which shows budget items for the conference.  

2. All text should be in Arial 12 point unless otherwise specified

3. Title the spreadsheet Professional Business Associates (16 point bold).  

4. On the second line add the words Workshop Costs (14 point italics).  

5. On the third line enter the current date.
6. All of these lines will be merged and centered over the worksheet after entering all the data.

7. Add rows for total and average costs, labeled appropriately.

8. Compute the total and average costs.

9. Format the numbers as currency with two decimal places.

10. Rotate the column headings 45 degrees and center them.  Add a single line border under the heading row.

11. Column width should be 30.  The rows following the column headings should have a height of 20.  Add a line to separate the table from the total and average rows.
12. Center the spreadsheet on the page, horizontally and vertically.

13. Print the spreadsheet with the formulas AND without the formulas.

14. Create an exploded pie chart showing the percentages and item next to the slices and exclude the legend.  Use the same title as the spreadsheet.
15. Print the chart on a full sheet.
Table 1

	Item
	Cost

	Publicity
	2000

	Speakers
	3500

	Postage/Mailing
	975

	Office Staff
	1588

	Materials
	1700

	Room Rental
	2900


Job 4:  Mail Merge

1. Using the letterhead you created in Job 1, the database from Job 2 and the chart from Job 3, create the following letter.

2. The letter is from Julie Smith, Human Resources Department Manager.

3. Do not include a subject line.   Use the recipient’s first name only in the greeting.
4. Send a copy of the letter to our CEO, Nancy Wells.

5. Print the letter with the merge codes displayed.

6. Merge the letters for participants from NY only and print.

Thank you for registering for our Dressing for the Job Interview workshop.  The conference is scheduled for July 21, 2007 in Columbus, Ohio at the Greater Columbus Convention Center.  Plan to arrive by 7:30 a.m. to join us for a continental breakfast.  The opening session will begin at 8:30 a.m. in Ballroom II on the second floor.  

We believe this workshop will help you evaluate future job candidates for Professional Business Associates as we expand into your state.  As a new member of our employment team, we also think you would be interested in the costs of the conference which are shown in the following chart.
[Insert pie chart here.]

We look forward to meeting with you in July.  A copy of the agenda will be faxed to you within the next couple weeks.  We have your fax number listed as:  [insert fax number here].  If this is incorrect please e-mail me at jsmith@pba.com.
Job 5:
Labels

Using the database prepared in Job 2, create mailing labels for all participants using Avery 5160.  Sort the labels in ascending postal code order.






